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INTRODUCTION 

Learning Objectives 
In this training session you will learn how to: 

• Import List Information from Microsoft® Excel 

• Establish ODBC Queries to Extract Information From QuickBooks 

• Build PivotTables and Charts based on QuickBooks Data Extracted via ODBC Connections 

• Integrate QuickBooks Data into Microsoft® Word-Based Documents 

• Integrate with QuickBooks Point of Sale and Other Third Party Applications 

• Locate Third-Party Tools and Utilities that Work with QuickBooks 

About this Course 
Given the popularity of QuickBooks in the marketplace, there is a strong chance that many of your 
small business clients use QuickBooks. In this course you will learn how to integrate QuickBooks data 
files with other market-leading applications such as Microsoft Excel, Word, and QuickBooks Point of 
Sale. Whether working with your own data files or those of clients, the integration techniques 
discussed in this program are designed to increase your knowledge basic integration concepts and 
how to use them to your advantage. 

There is a fundamental assumption in this course that participants already have a solid working 
knowledge of QuickBooks operations such as establishing preferences, entering and editing items, 
and recording transactions such as bills, invoices, and checks. As such, this course is not designed to 
provide an in-depth review of matters such as these. 
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About QuickBooks Accountant Edition 
QuickBooks 2008 Premier Accountant edition and QuickBooks Enterprise Solutions Version 8 
Accountant Edition will be used as the demonstration software in this manual and the related webinar. 
QuickBooks Enterprise Version 8 and Premier Accountant Edition 2008 include all of the features of 
the QuickBooks Enterprise and Premier Editions with the additional features needed to help 
accountants support clients who use QuickBooks. QuickBooks Premier Accountant Edition 2008 and 
QuickBooks Enterprise Solutions Accountant Edition 8.0 include all of the features available in each 
industry-specific edition of QuickBooks:  Contractor Edition, Non-Profit Edition, Professional Services 
Edition, Manufacturing and Wholesale Edition, and Retail Edition. For each of these industry types, 
Accountant Edition includes: 

• Industry-Specific Reports and Memorized Reports 

• Industry-Specific Help Menu Content 

• Industry-Specific Form Templates 

• Industry-Specific Sample Company Data Files 

QuickBooks Premier Accountant Edition 2008 can read all editions of QuickBooks 2008 (Simple Start, 
Pro, Premier and Premier: Industry-Specific editions) without converting the data. The accountant can 
open the client’s data file, make changes using the Accountant Edition and return the file to the client 
for them to restore using their own edition of QuickBooks 2008. QuickBooks Enterprise Solutions 8.0 
Accountant Edition functions in this same way with all editions of QuickBooks Enterprise Solutions 8.0. 

QuickBooks Premier Accountant Edition and QuickBooks Enterprise Solutions Accountant Edition are 
included in the benefits of the QuickBooks ProAdvisor program. 
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CHAPTER 1:  
EXCHANGING QUICKBOOKS LIST DATA WITH 
MICROSOFT EXCEL 
When used effectively, Microsoft® Excel can be a useful tool for working with QuickBooks data. 
Specifically, it can be used to import list information from non-QuickBooks sources, to “fix” some of the 
most common list problems found in client data files and, finally, it can be used as a reporting tool that 
allows you to view QuickBooks data in ways not possible from within the program itself. The 
techniques presented in this course will not only increase your efficiency with QuickBooks and Excel 
operations but can also help to make you more productive and effective when working with your 
QuickBooks clients. 

Importing List Information from Excel 
This section describes how to import list information stored in Excel files into QuickBooks. You can 
import data for the following four lists directly from Excel: 

• Chart of Accounts 

• Vendors 

• Customers 

• Items 

QuickBooks 2008 provides a tool that lets you import Excel data using pre-formatted Excel 
spreadsheets. This import option, which is limited to customers, vendors, and items provides step-by-
step instruction on how to copy and paste list information from a source list (including CSV, Outlook, 
and Peachtree) into the formatted template, making it easier to import information. In this course we 
will be covering how to import data using the Advanced Import option in QuickBooks. 

EXCHANGING QUICKBOOKS LIST DATA  

WITH MICROSOFT EXCEL 
Importing List Information from Excel 
Exporting QuickBooks Lists to Excel 
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To import data using the Advanced Import feature: 

1. From the File menu, select Utilities, then Import, then Excel Files to open the Add Your Excel 
Data to QuickBooks wizard shown in Figure 1. 

 

 
Figure 1 – Adding Excel Data to QuickBooks 

2. Click Advanced Import. 
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3. Indicate the names of both the workbook and the worksheet to be imported, as highlighted in 
Figure 2. 

 

 
Figure 2 -- Import a File Window (Used to Import an Excel File) 

In addition, it is necessary to indicate whether the worksheet to be imported has a Header 
Row. A header row is simply a row of column labels in the worksheet describing the contents 
of each column. In the worksheet shown in Figure 3, a header row is used to indicate that the 
contents of Column A represent “Customer Code,” the contents of Column B represent “First 
Name,” the contents of Column C represent “Last Name,” etc. 

 

 
Figure 3 -- Worksheet Sample Indicating Header Row 

4. Specify a Data Map. 

A data map is used to control the flow of the information stored in columns in Excel into the 
appropriate fields in the QuickBooks data file. For example, the data map will ensure that the 
data in the “Email” column in the Excel worksheet is stored in the “Email” field in the 
QuickBooks data file.  

Note that when importing 
customer address information, 
QuickBooks requires that the City, 
State and Zip be in the same cell. 
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If this is the first import that has been done from this worksheet, you’ll need to create a data 
map. To do so, click the drop-down list next to Choose a mapping and select <Add New> as 
shown in Figure 4. 

 

 
Figure 4 -- Adding a New Data Map 

5. In the resulting Mappings window, enter a Mapping name and Import Type as shown in Figure 
5. 

6. Click in the Import data column next to each relevant field in the QuickBooks column and 
indicate which column of Excel data should be “mapped” to that field in the QuickBooks data file. 
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It is not necessary to map an Excel column to each field in the QuickBooks data file.  
 

 
Figure 5 – Creating a Customer Data Map 

7. Click Save to save the data map for future use. 

Once the map has been created and saved, the Import a file window appears.  

8. Click Import to import the Excel data into the QuickBooks database. 

The ability to import Excel-based data into QuickBooks can save significant amounts of time when 
establishing a new company or when converting a company from another accounting software 
application. Provided the other application can export customer, vendor, chart of account, and item 
information to Excel (or to a text file that can be opened and manipulated in Excel), the QuickBooks 
import from Excel function makes converting that data into QuickBooks data a quick and easy 
process. 

Exporting QuickBooks Lists to Excel 
There are numerous lists that can be exported out of QuickBooks. Often, these lists are exported out 
of one QuickBooks data file and imported into another. Occasionally, you may want to export a list to 
Excel so that you can more easily update customer vendor and item information, for example, and 
then re-import the updated list back into the QuickBooks file. 

Enter Mapping 
name and 
Import type. 

Select the 
appropriate column 
from the Excel 
worksheet to enter 
into the 
QuickBooks data 
file. 

Note that 
QuickBooks requires 
that the  

City, State, Zip 

appear on one line 
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To export the Item list: 

1. From the File menu, choose Utilities, and then choose Export, and then choose Lists to .IIF 
files. 

“IIF” stands for Intuit Interchange File Format. 

2. Check Item List as the list you would like to export. See Figure 6. 
 

 
Figure 6 -- Exporting Lists from QuickBooks 

3. Save the exported file to a location that is easily accessible and then open that file with Excel.  
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4. To open this file in Excel, change the file type in the Open File window to All Files (*.*). See 
Figure 7. 

 

 
Figure 7 – Opening the Exported Item List File in Excel 

5. Follow the prompts that will allow Excel to open the IFF file (which is a delimited file).  

See Figure 8.  
 

 
Figure 8 -- Step One of the Excel Text Import Wizard 
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6. Click Next. 

7. Accept Tab as the Delimiter type and click Next. 

See Figure 9. 
 

 
Figure 9 – Selecting Tab as the Text Delimiter 
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8. Accept the Column data format as General. 

9. Click Finish to view the complete list in Excel. See Figure 10. 
 

 
Figure 10 –  Setting the Column Format to General 

The same rules that apply to making changes to a list while it is in QuickBooks (in our 
example, the Item list) apply to when it is out of QuickBooks. This means that, for example, 
QuickBooks will not accept for re-import those Inventory or Service items where the type has 
been changed in Excel. In our example, we want to make several of the old service items 
inactive. This can be done by inserting a “Y” in the “HIDDEN” column for each of the items in 
the list that we want to make inactive. You may want to use the copy and paste function. 
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10. Click Save when done. See Figure 11. 
 

 
Figure 11 – Partial View of an Item List in Excel 

11. Save the file in its original format - Text (Tab delimited) (*.txt). See Figure 12. 

This maintains the .IIF format, which is necessary for easy import back into QuickBooks. 
 

 
Figure 12 – Saving the Updated File as a Text File 
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12. When prompted, click Yes to replace the existing .IIF file. See Figure 13. 
 

 
Figure 13 – Item Exists Prompt 

13. Click Yes again to keep the saved workbook in the existing format.  

14. Close the workbook, and when prompted again click Yes to save the changes made to the .IIF file. 
See Figure 14. 

 

 
Figure 14 – File Format Request Dialog Box 

15. From the QuickBooks File menu, choose Utilities, then Import, and then choose IIF Files, and 
browse to the .IIF file that you’ve just saved with your changes. 

16. Highlight the import file and select Open.  

The modified list will now be imported and the Item list updated. 
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CHAPTER 2:  
CREATING ODBC CONNECTIONS WITH 
QUICKBOOKS 

Introducing Open Database Connectivity 
Open Database Connectivity (ODBC) is a specification designed by Microsoft that allows you to share 
information in a database across multiple, diverse applications. For users taking advantage of ODBC, 
the benefits include: 

• Allowing Windows applications to access multiple data sources through a single method, 
regardless of file formats. 

• Overcoming the problem of different databases having different means of providing access to the 
information contained in them. 

• Simplifying access requirements so that users no longer require advanced database management 
skills in order to access data. 

Examples of applications that are compliant with ODBC include Microsoft SQL Server, Microsoft 
Access, Microsoft Excel, Borland® Delphi, Crystal Reports, and Microsoft® Visual Basic. This means 
that a user of Excel, for instance, could access data contained in a Microsoft SQL Server database to 
create custom reports or queries. In addition, because a QuickBooks database can be accessed via 
an ODBC connection, it also can be queried to return data to Excel (or any other ODBC-compliant 
application) for purposes of creating custom reports, analytical procedures, generating PivotTables 
and PivotCharts, or any other necessary function. 

 

 

 

 
Figure 15 – Example of Sharing QuickBooks Data via ODBC 

CREATING ODBC CONNECTIONS WITH 

QUICKBOOKS 
Introducing Open Database Connectivity 
Installing and Configuring the QODBC Driver 
Integrating with QODBC to Export QuickBooks Data 
Working with PivotTables Dynamically Linked to 
QuickBooks Data 

SQL
Server
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QODBC provides you with an application that adds ODBC capabilities to QuickBooks databases. For 
example, using QODBC, you can extract information from a QuickBooks file into a Microsoft® Access 
database. In addition to pulling data from a database, ODBC technology can be used to push 
transactions back into a database.  

Many applications are ODBC-compliant already, including Excel, Access, Word, and most other 
accounting applications. With QuickBooks, the use of an ODBC driver such as QODBC is required in 
order to facilitate the data transfer. QODBC is offered by FLEXquarters.com, LLC 
(www.flexquarters.com). Additionally, for users of QuickBooks Enterprise Solutions, QODBC is 
provided with that application. 

In addition, with QODBC installed, you have the ability to share QuickBooks data with a wide range of 
applications. Examples of practical applications of using QODBC to extract information from 
QuickBooks include the following: 

• Importing QuickBooks information into Excel where a PivotTable is used to analyze sales data. 

• Performing mail merges directly in Word. 

• Linking PowerPoint presentations to QuickBooks data that have been imported via an ODBC 
connection into Excel. 

Installing and Configuring the QOBDC Driver 
This first part of this section describes how to install and configure the QODBC driver from within 
QuickBooks Enterprise Solutions editions. The second part describes how to install and configure the 
driver when it has been downloaded from the FLEXquarters.com, LLC web site. 

Installing the Driver from within Enterprise Solutions 
To install the driver included with QuickBooks Enterprise Solutions: 

1. From the File menu, choose Utilities, then Set up ODBC. 
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2. Click Download Driver, as shown in Figure 16. 
 

 
Figure 16 – The Initial ODBC Driver Download Page 
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3. Click Download QODBC Driver to continue with the download process. 

Once downloaded, the driver installs automatically. 

Next, you’ll need to configure the driver to work with the QuickBooks Enterprise company data file. 

Configuring the Driver 
The driver does not access QuickBooks directly, but instead interfaces with a secondary database, 
called the Optimizer. The Optimizer is attached to QuickBooks and uses the QuickBooks Software 
Development Kit (SDK), which means a safe, secure, and consistent set of rules are applied for 
accessing data. 

There is a separate optimizer file for each QuickBooks company file, and the data is encrypted for 
security. The files have an OPT extension and are saved separately. 

While the initial optimization can take a long time (up to several days with large Enterprise Solutions 
files), the Optimizer holds QuickBooks data so that you can run reports quickly after the initial 
optimization. 

To configure the driver: 

1. From the File menu, choose Utilities, and then choose Configure ODBC. 

The Driver Setup Window, shown in Figure 17, opens with the General tab displayed.  

Note that the default data source is the Enterprise company data file that is currently open. For 
most users, this is the appropriate setting. In most cases, you’ll want to leave the “Mode when 
Opening” option set to the default “Same as company” file option, which allows the QODBC 
driver to access the QuickBooks data file in the same manner (and with the same 
permissions) as the QuickBooks user who is logged into the file during that session. 

 

 
Figure 17 – The General Tab of the Driver Setup Wizard 

 

Default data source. 

The default mode setting of “Same as 
company file” means that the QODBC 
driver accesses the QuickBooks data 
file with the same permissions as the 
signed in QuickBooks user. 
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2. Click the Messages tab. 

3. Select the settings that allow the display of the Driver and the Optimizer Status Panel  
as shown in Figure 18. 

All other settings on this tab can be left in their default position. 
 

 
Figure 18 – The Messages Page of the Driver Setup Wizard 

4. Click the Optimizer tab. 

5. Make sure the Use Optimizer checkbox is checked. 
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6. Indicate how often to optimize the data. 

We recommend that the optimized data be updated at the start of every new 
ODBC/QuickBooks connection as shown in Figure 19. 

 

 
Figure 19 – The Optimizer Tab of the QODBC Setup Wizard 
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Installing the Driver Purchased from Flexquarters.com 
The read-only QODBC Driver (as well as read-write editions) can be purchased and downloaded 
directly from Flexquarters.com. The information in this section describes how to install the driver when 
it’s been purchased and downloaded from flexquartersc.com versus installed from within QuickBooks 
Enterprise Solutions. 

To install the driver from flexquarters.com: 

1. Click the link to download the driver. 
 

 
Figure 20 – The QODBC Download Page 

After downloading and installing the driver, you can access it from the Windows Control Panel 
in Administrative Tools. 

2. Click the Administrative Tools icon, then Data Source (ODBC). 
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3. On the System DSN (Data Source Name) tab shown below, click Configure and complete the 
driver configuration as outlined in the previous section. See Figure 21. 

 

 
Figure 21 – Configuring the QODBC Driver 

Integrating with QODBC to Export QuickBooks Data 
This section provides an example of integration between QuickBooks and other applications using 
QODBC. 

A key to taking the greatest advantage of the ability to integrate with QOBDC is an understanding of 
the QuickBooks data tables. At Flexquarters.com you can get an easy-to-understand description of the 
data table layout in QuickBooks and a listing of these tables and fields and how they are related to 
specific forms (invoices and bills, for example) within a QuickBooks file.   

To view these data table layouts, go to the following site: www.qodbc.com/schema.htm. 

Extracting Live QuickBooks Data 
The following example illustrates the ease with which “live” data can be extracted from QuickBooks for 
analysis outside of the program using QODBC. In this example, we’ll extract data to send to Excel a 
list of customers with balances greater than $1000.00. 

To extract data: 

1. Open the QuickBooks file from which you want to extract data. 

2. Launch Microsoft Excel. 
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3. From the Data menu in Excel, choose Import External Data. 
 

 
Figure 22 – Starting a New Database Query in Excel 

4. Select New Database Query.  

This launches Microsoft Query. 

5. Select QuickBooks Data as the data source and click OK. 
 

 
Figure 23 – Selecting QuickBooks as the Data Source for a Query 

A window opens that contains all of the available tables in the QuickBooks database.  

6. Select the desired QuickBooks fields and tables. 
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Since customer-related information is to be extracted in this example, the Customer table is 
selected. In this example, the FullName and TotalBalance QuickBooks fields (referred to as 
Columns in the Query Wizard) within the Customer table are selected by clicking the  
right-arrow button in the middle of the window. This is illustrated in Figure 24. 

 

 
Figure 24 – Selecting Data to be Included in Query 

7. Click Next to continue. 

You are then presented with a filtering option, as shown in Figure 25. 

8. Highlight the TotalBalance Column and choose the filter “is greater than” and enter 1000 in the 
field to the right. 

 

 
Figure 25 – Filtering Data Using the Query Wizard 
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9. Click Next. 

In this example we will not be doing any additional sorting.  

10. Click Next on the Sort Order window of the Query Wizard. 
 

 
Figure 26 – Sorting Options Using the Query Wizard 

When you click Next in the window shown in Figure 27, you are asked where the data is to be 
placed. Note that if this query is one that will be used repetitively, you can save the query for 
future use, eliminating many of the steps required up to this point. 

 

 
Figure 27 – Completing the Query Wizard 

11. Click Finish to open the Import Data window shown in Figure 28.  
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12. Indicate where the data is to be placed upon extraction. 

In this example the data will start in row one, column A. 
 

 
Figure 28 – Import Data Window 

13. Click OK in the Import Data window (shown above) to extract the data and place it into Excel as 
shown in Figure 29. 

 

 
Figure 29 – QuickBooks Data Extracted Into Excel Showing Customers with Balances Greater than 
$1000.00 

Once the data has been extracted and placed into Excel, you can manipulate it in any way necessary 
for analysis and reporting. Examples of Excel-based tools for such analyses and reporting include 
Filters, Data Subtotals, Grouping, and inserting Charts. 

Working with PivotTables Dynamically Linked to 
QuickBooks Data 
PivotTables are considered by many to be the most powerful function provided by Excel. With a 
PivotTable, a user has the ability to create financial statements and reports in a true drag-and-drop 
environment. Further, once a PivotTable has been created, it can be easily modified by dragging-and-
dropping fields to new locations, adding fields, sorting and grouping information, and even performing 
calculations based on the data in the PivotTable – without entering formulas! 

QuickBooks contains one built-in PivotTable. 
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To access the built-in table: 

• From the Reports menu, choose Employees & Payroll, and then choose Summarize Payroll 
Data in Excel.  

Selecting this feature produces an Excel workbook with eleven payroll-related PivotTables 
predefined for users’ input; an example of one of these tables is provided below in Figure 30. 

 

 
Figure 30 – Rates & Hours PivotTable 
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By clicking on any of the drop-down arrows in the PivotTable shown above, you can apply filters to the 
underlying data. Clicking and dragging on fields such as Customer:Job allows the field to be 
relocated to another location on the report in literally a matter of seconds. In Figure 31 below, the 
PivotTable has been rearranged; the Customer:Job field has been filtered to just two entries; and the 
Item Type field has been unfiltered. The entire process took less than ten seconds, and yet the report 
is dramatically different in scope. 
 

 
Figure 31 – Modified PivotTable 

Creating PivotTables Based on QuickBooks Data 
For users seeking to embrace PivotTables as a means of generating powerful reports providing 
tremendous amounts of analytical insights, the payroll PivotTable, unfortunately, is the only such 
PivotTable found in QuickBooks. However, using ODBC connections, it is possible to create 
PivotTables in Excel that are dynamically linked to the underlying QuickBooks data. 

Analyzing Sales on an Item Level by Zip Code 
The following is an example how to take advantage of PivotTables. 

With a QuickBooks file open and with QODBC installed, you can begin the process of creating the 
PivotTable in Excel. 

To create a pivot table: 

1. From the Excel Data menu, choose PivotTable, and then choose PivotChart Report from the 
submenu. 
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This launches the PivotTable and PivotChartWizard, as shown in Figure 32. 

2. Indicate that the source of the data is an External data source, as shown below, and click Next. 
 

 
Figure 32 – Step 1 of the PivotTable and PivotChart Wizard 

3. In Step 2 of the Wizard, click Get Data as shown in Figure 33. 
 

 
Figure 33 – Step 2 of the PivotTable and PivotChart Wizard 

Excel opens Microsoft Query. 



 

30 

4. In the Choose Data Source window of Microsoft Query, select QuickBooks Data as the Data 
Source and click OK. See Figure 34. 

 

 
Figure 34 – Selecting the Data Source in Microsoft Query 

Microsoft Query presents a window with all of the available tables in the open QuickBooks 
data file. 

5. For our Pivot Table Analysis, select InvoiceLine and note in the Columns Query window the 
specific fields to be included in the PivotTable (click on the table and/or field and then clicking on 
the directional arrows as shown below in Figure 35).  

6. Once all fields have been added, click Next to continue. 
 

 
Figure 35 – Adding Fields to the Query 
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A series of prompts are presented, allowing filtering and sorting of the data.  

7. Click Next through both of these prompts as any filtering and sorting can be done inside the 
PivotTable.  

The final step of writing the query to extract the data for the PivotTable is to indicate the 
disposition of the data.  

8. If no changes are required, select Return Data to Microsoft Office Excel and click Finish as 
shown below in Figure 36. 

If additional fields from other tables are required, select View data or edit query in Microsoft 
Query, and it is possible to add other related tables and fields to the query. 

 

 
Figure 36 – Final Step of Writing the Query for a PivotTable 

When you click Finish in the window shown in Figure 36, you are returned to Step 2 of the 
PivotTable and PivotChart Wizard. 

9. Click Next to proceed. 

10. In Step 3 of the PivotTable and PivotChart Wizard, indicate where the PivotTable should be 
located. 



 

32 

Often, it is advisable to place the PivotTable on a new worksheet with no additional 
information on that sheet; this is done by selecting New worksheet, as shown on the next 
page in Figure 37. 

 

 
Figure 37 – Step 3 of the PivotTable and PivotChart Wizard 

11. Click Finish to make the outline of the PivotTable to become visible in Excel. 

12. Click and drag fields to the desired locations, and the PivotTable is completed. See Figure 38. 
 

 
Figure 38 – PivotTable Outline with Arrows Indicating Where Fields will be Dragged 
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The resulting PivotTable in this example – shown in Figure 39– shows total sales by Item by Zip Code 
for all dates and is based on the structure of the PivotTable as it was defined in Figure 38. The 
underlying data is linked to the QuickBooks data file and can be refreshed either manually or 
programmatically. Of course, fields can be rearranged, grouped, hidden, or formatted to meet specific 
user needs and desires, and calculations can be added to the PivotTable as necessary. 
 

 
Figure 39 – Completed PivotTable Linked to QuickBooks Data 

Now using the data as arranged in the Pivot Table you can create a Pie Chart that allows you to view 
the data and rearrange it in ways to show trends that are not always visible when viewing the 
information in a static report. 
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To open the Pivot Table Wizard: 

1. From the Insert menu, choose Menu, and then choose Charts. 

You’ll now see Step 1 of the Chart Wizard. 
 

 
Figure 40 – The Pivot Table Chart Wizard 

2. Click through to Set 4 of the Wizard and return the information to a new sheet. 
 

 
Figure 41 – Step 4 for the Chart Wizard 
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3. Alternately move the Fields in the Pivot Table Field List box to the Legend box to change the date 
range and fields represented by the Pie Chart. 

 

 
Figure 42 – Viewing Pivot Table Data in a Pie Chart 

In sum, creating PivotTables that are dynamically linked to QuickBooks data files is a relatively simple 
and easy process and provides users with a significant advancement in financial and operational 
reporting. 
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CHAPTER 3:  
INTEGRATING WITH MICROSOFT WORD 
One of the strengths of QuickBooks software is that it provides integration capabilities with a number 
of leading applications, including popular components of Microsoft Office in addition to Excel. This 
extends the functionality of QuickBooks across horizontal as well as vertical markets. In this section, 
various options to integrate QuickBooks with Microsoft Word are examined. 

Working with Microsoft Word 
QuickBooks provides strong integration with Microsoft Word, allowing users to generate invoices to 
customers and mail-merge letters based on entries in various QuickBooks lists.1 In this section, you’ll 
learn how to pull invoice information from QuickBooks to populate letters created in Microsoft Word. 
You’ll also learn how to do a mail-merge in Word using information from QuickBooks lists. 

                                                                          
1 This feature requires QuickBooks Pro or higher editions and Microsoft Word 2000, 2002, 2003, or 2007. 

INTEGRATING WITH MICROSOFT  WORD 
Working with Microsoft Word 
Preparing Invoices with Microsoft Word 
Merging QuickBooks Data into Microsoft Word Documents 
Customizing Templates 
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Preparing Invoices in Microsoft Word 
Using the integration feature between QuickBooks and Word, you can prepare invoices in Word using 
QuickBooks data. 

To create an invoice letter: 

1. Create the invoice in QuickBooks as usual, and click the Letters icon in the upper, right-hand 
corner of the window as shown in Figure 43. 

 

 
Figure 43 – Initiating an Invoice in Microsoft Word Based on QuickBooks Data 

2. Select the desired template or create a new template to meet specific needs.  

Click here to export invoice 
details to Word. 
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In the example shown in Figure 44, the predefined “Invoice Letter with Details” template has 
been selected. 

 

 
Figure 44 – Selecting a Template for an Invoice to be Created in Microsoft Word 

3. Click Next as indicated in Figure 44 and follow the steps directed by the wizard to complete the 
process of generating the invoice in Word.  

Once the invoice has been prepared in Word, it can be edited as necessary to meet specific 
formatting or data requirements. Figure 45 provides an example of a Word-based invoice 
document created using this process. 

 

 
Figure 45 – Excerpt of Invoice Document Created in Word 
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Merging QuickBooks Data into Microsoft Word Documents 
In addition to creating invoice documents in Microsoft Word, QuickBooks also provides users with the 
option of quick and easy mail-merge letters that can be created based on information contained in the 
following QuickBooks lists: 

• Customer:Job List 

• Vendor List 

• Employee List 

• Other Names List 

These letters can be based on one of the predefined templates supplied with QuickBooks, a modified 
template based on one of the predefined templates, or a template created from scratch. 

To begin the process of creating mail-merge letters: 

1. From the Company menu, choose Prepare Letters with Envelopes, and the type of letter to be 
created as shown in Figure 46. 

 

 
Figure 46 – Selecting Vendor Letters as the Type of Letter to be Created in Mail-Merge 

In this example, a letter will be sent to one or more of the company’s vendors.  
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2. Select which vendor(s) by placing checkmarks next to the appropriate names as shown  
in Figure 47. 

 

 
Figure 47 – Selecting Recipients for Vendor Letters 

3. Select the type of letter to be sent; as shown in Figure 48, the Disputed Charge Template has 
been selected for this example. 

Note that templates may be created, and existing templates may be modified. 
 

 
Figure 48 – Selecting the Predefined Disputed Charge Template 
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You are prompted next for the name and title of the person signing the letter. Once these 
fields have been entered, the letter is created and displayed in Word. An excerpt is shown 
below in Figure 49. 

After the letter has been created, it may be edited, or it may be used “as-is.” Further, an 
accompanying envelope may be generated as part of this process. 

 

 
Figure 49 – Excerpt of Mail-Merge Letter 

Modifying Letter Templates 
The Manufacturing and Wholesale edition of QuickBooks Premier and QuickBooks Enterprise 
Solutions comes with blank templates that you can use to issue an Authorization to Return 
Merchandise (RMA) as well as a Non-Conforming Material Report (used to record information about 
material that does not conform to the vendor’s specifications) and a Damaged Goods Log. In this 
section, we’ll use this form as an example in demonstrating how to customize a letter template. 

Using the Customize Letter Template wizard you can eliminate the need to enter basic company and 
customer information when issuing an RMA to a customer.  In addition, once modified you can use this 
customized RMA form in other editions of QuickBooks. 
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To modify the RMA form: 

1. From the Mfg & Whsle menu in QuickBooks Manufacturing and Wholesale edition, select 
Inventory Activities, and then choose Customer Return Materials Authorization Form. 

 

 
Figure 50 – Opening the Customer Return Materials Authorization Form 

Once it’s been opened you may save it as a Word document in a location of your choice. 

2. Using any version of QuickBooks that supports integration with Microsoft Word, open the 
Customize Letter Templates wizard located under the Company menu.  
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3. Choose the option to Convert an Existing Microsoft Word Document to a Letter Template. 
 

 
Figure 51 – Converting a Microsoft Word Document to a Letter Template 

4. Navigate to the saved document, choose the type of template to save it as, and name the 
template. 

 

 
Figure 52 – Locating and Creating the Template 

Using the Template Wizard you can now insert Company and Customer Fields into the RMA 
Template.  You can also import a logo to further customize the template if you wish. 

5. Once you’ve completed your modifications, save your changes. 
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The modified template is now a part of your saved QuickBooks letter templates, available for 
use at any time. 

 

 
Figure 53 – Inserting Fields into the RMA Template 

Place your 
cursor in the 
desired field on 
the document 
and then insert 
the “link” to the 
appropriate 
QuickBooks 
information. 
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CHAPTER 4:  
INTEGRATING WITH OTHER APPLICATIONS 
To allow for the creation of additional software solutions that integrate with QuickBooks, Intuit opened 
the QuickBooks database to other applications through the QuickBooks Software Development Kit 
(SDK). The QuickBooks SDK does the following: 

• Acts as the bridge that connects QuickBooks to other business software applications. 

• Provides a consistent and safe method of reading and writing data to QuickBooks. 

You can extend the capabilities of QuickBooks by using integrated applications. When software is 
integrated with QuickBooks, selected sales, customer, or financial data can move between software 
products automatically, saving time by reducing the amount of data entry necessary and reducing the 
chance for data entry errors.  

QuickBooks Point of Sale2 is an application designed to manage retail stores. Specifically, it allows 
retailers to easily process sales transactions, track customer information, and manage inventory.  
QuickBooks Point of Sale can be integrated with QuickBooks (Pro and Premier 2005-2008 and 
Enterprise Solutions version 5.0 – 8.0) to give the retailer complete, unified control over the entire 
retail operation.  Intuit uses the QuickBooks SDK to integrate QuickBooks with QuickBooks Point of 
Sale.   

In this section, you’ll explore the integration between QuickBooks and QuickBooks Point of Sale as 
one example of working with integrated applications. 

You’ll also learn about where you can go to find more applications created by third-party developers 
that not only extend the functionality of QuickBooks but also give consultants the tools they need to 
work with and “fix” common data file problems. 

Basic Considerations when Integrating QuickBooks with 
Other Applications: 
• Choose an application that gives you the most control over how information is shared between the 

two programs. 

• Consider the reporting needs of the client from within QuickBooks prior to integrating any 
application—being careful to choose “mapping” options that maintain the integrity of existing 
QuickBooks reports. 

• Use the Audit Trail as a tool to monitor/track changes made to the QuickBooks data file by a 3rd 
Party Application. 

                                                                          
2 QuickBooks Point of Sale sold separately. 
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Tracking Transactions Posted to QuickBooks by  
Third-Party Applications 
Use the information in this section to learn how to set up QuickBooks to allow you to create a record of 
the transactions posted to a QuickBooks data file by third-party applications. 

To track transactions posted by third-party applications: 

1. Set up a new user in QuickBooks, preferably using a name that easily identifies the application. 

This user does not have to have to be granted Full Access Rights at the User Level – access 
to QuickBooks will be defined in the Integrated Applications preferences. 

2. Establish the initial connection between the two programs. 

3. In QuickBooks, set the Access Rights in the Integrated Applications preference for the outside 
application to “read and modify this company file.” 

4. In QuickBooks, set the Login as (in the Access Rights area in Integrated Application references) to 
the third-party application user name. 

 

 
Figure 54 – Setting the Access Rights in QuickBooks 

Integrating with QuickBooks Point of Sale 
When you integrate QuickBooks with QuickBooks Point of Sale (POS), existing inventory items, 
customers, and vendors from the financial software can be imported into QuickBooks Point of Sale 
and all of the daily sales data can be sent (in either a summarized or detailed format) to the financial 
software. 

The following describes which features and functionality are available in each application. 

In QuickBooks Point of Sale, you do the following: 

• Record Sales—Process customer sales, returns, sales orders; accept cash, checks, credit/debit 
cards, gift cards and gift certificates. 



 

49 

• Track Inventory—Track on hand and available quantities, reorder points, vendor information, items 
descriptions, item costs and selling prices. 

• Purchase and Receive Inventory—Place purchase orders, receive items into inventory, track 
purchasing and receiving history. 

In QuickBooks Financial, you do the following: 

• Maintain the General Ledger—Keep track of bank balances, perform bank reconciliations, 
maintain asset/liability balances, including accounts payable and accounts receivable. 

• Pay bills/write checks— Manage accounts payable, cash disbursements, and accounts receivable. 

• Maintain payroll—Pay employees, keep track of withholdings and benefits. 

• Generate financial reports—Keep track of the company’s finances, generate reports for 
management and tax preparation. 

Allowing QuickBooks Point of Sale Access to QuickBooks 
The Integrated Applications preferences window shown in Figure 55 is where you manage all 
applications that integrate with QuickBooks – including QuickBooks Point of Sale. You’ll notice that the 
integrated applications that you launch from within QuickBooks (i.e., Fixed Asset Manager and 
Financial Statement Designer are listed here). 

To set up QuickBooks to allow access to QuickBooks POS: 

1. From the Edit menu, choose Preferences, and then choose Integrated Applications. 

2. On the Company Preferences tab, make sure the “Don’t allow any applications to access this 
company file” checkbox is clear. 

 

 
Figure 55 – QuickBooks Integrated Applications Preferences 
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3. In QuickBooks POS, select the “Use with QuickBooks Financial Software” checkbox in the 
Financial preferences as shown in Figure 56. 

 

 
Figure 56 – Connecting QuickBooks POS with QuickBooks Financial Software 

4. Use the QuickBooks Connection Wizard to connect with the QuickBooks company file. 

Once the connection has been established with an integrated application, QuickBooks lists the 
application name in the Preferences window.  

You define how the application accesses the company (in particular, the application’s login 
name) file and how much information you want to share between the application and 
QuickBooks by highlighting the name of the application in the list and clicking Properties, 
which opens the Access Rights window. 

 

 
Figure 57 – Integrated Application Preferences in QuickBooks 
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Setting Integration Properties within QuickBooks Point of Sale 
You can control how and where information from QuickBooks Point of Sale appears in the financial 
software using the Financial preferences in QuickBooks POS as shown in Figure 58. 
 

 
Figure 58 – The Main Financial Menu in the Point of Sale 

Note that both a Main Financial page and an Accounts sub-section exist.  On the Main Financial 
window, you can: 

• Turn on the option to “link” or integrate this Point of Sale company file with a specific QuickBooks 
Financial company file. 

• Access the QuickBooks Connection Wizard, which makes linking the two data files simple. 

• Use the option to send sales receipts and receiving voucher information in either a detailed or 
summarized format. The default and recommended format is summarized. 

• Select the order in which you want customer names sent to QuickBooks: <Last>, <First> default; 
<First Last>; <Title First Last>. 

• Choose to send discounted item information as a net amount or separately.  

By default, Point of Sale sends discounted item sale amounts to QuickBooks financial 
software in "net" amounts, (i.e., the discount amount is not accounted for separately). This 
preference can be used to send both the original item price and the discounted price, so that 
you can use QuickBooks reports to see how discounts are affecting the bottom line. 
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The Accounts page allows you to control where specific Point of Sale transactions and activities 
appear in the financial program, as shown in Figure 59.  Note that there are Basic and Advanced 
mapping options.  The Basic tab allows you to control how items are tracked in QuickBooks.  
 

 
Figure 59 – Basic Account Mapping Preferences 



 

53 

The Advanced tab gives you control over where Point of Sale activities appear in the financial 
company file. See Figure 60. 
 

 
Figure 60 – Advanced Account Mapping Preferences 
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Understanding how Point of Sale Transactions are Posted in 
QuickBooks 
When the default “Send Receipts” method of Summarized is used, the day’s cash and credit card 
sales transactions are sent to the financial software as a single sales receipt – including a separate 
total for each credit card type. See Figure 61. 
 

 
Figure 61 – Daily POS Cash and Credit Card Transaction Totals as Recorded in QuickBooks Financial 

All sales paid for via check are sent as separate sales receipt (for each check tendered). 

See Figure 62. 
 

 
Figure 62 – A POS Check Transaction as Recorded in QuickBooks Financial 
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Understanding How Payments from QuickBooks Point of Sale Are 
Posted in QuickBooks 
By default all payments taken in QuickBooks Point of Sale, with the exception of cash (which is 
deposited directly to the Cash in Drawer Account in QuickBooks Financial), are posted to the 
Undeposited Funds account in QuickBooks during Financial Exchange.  Credit cards of the same type 
are grouped together and arranged according to date while checks are listed individually according to 
date.  From here credit cards should be selected for deposit into the bank account so that they match 
the daily batch total from credit card merchant service. See Figure 63. 
 

 
Figure 63 – Payments from the Point of Sale to be Deposited 
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Accounts Created by QuickBooks Point of Sale in QuickBooks 
Financial 
As a QuickBooks consultant it is useful to know what accounts are automatically created by 
QuickBooks Point of Sale when it is integrated with QuickBooks Financial Software.  The chart below 
details each account, its type and the information from the Point of Sale that is tracked in that account. 
 

Accounts Created in 
QuickBooks Financial by 
QuickBooks Point of 
Sale 

 

Account Type Capture These Transactions 
from QuickBooks Point of Sale 

Employee Tips Payable Other Current Liability Tips collected on non-cash 
transactions 

Gift Cards Outstanding Other Current Liability Gift Cards Issued 

Unbilled Purchases Other Current Liability Receiving vouchers that do not 
include a vendors bill information 

Service Sales Income Income from Service Items sold 
at the Point of Sale 

Shipping and Delivery 
Income 

Income Income from Shipping and 
Delivery Items 

Purchases – Resale Items Cost of Goods Sold Cost of Non-Inventory Items Sold 

Subcontracted Services Cost of Goods Sold Cost of Service Items Sold 

Cash Drawer Payouts Expense Cash taken from the cash drawer 
for expenses 

Freight and Shipping 
Costs 

Expense Freight In costs for merchandise 

POS Inventory 
Adjustments/  

Document Offset 

Expense Adjustments made to an 
inventory item’s cost or quantity 
directly in the item record 

Purchase Discounts Expense Discounts recorded on a 
Receiving Voucher 
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Using Third-Party Tools and Utilities 
QuickBooks Point of Sale is just one example of an application that integrates with QuickBooks 
through the SDK. There are many other applications that integrate with QuickBooks available through 
the Intuit Developer Network.  

The software applications in the QuickBooks Solutions Marketplace were created by third-party 
software companies. These companies are part of the Intuit Developer Network that wanted to enable 
their software to help QuickBooks users. These applications can help you find software solutions that 
seamlessly integrate with QuickBooks software to solve clients’ business needs. 

Products are rated and reviewed by QuickBooks owners who have used them. You can use these 
ratings as a basis for determining the quality of the software, its pros and cons, and whether it's right 
for a particular business. In many cases, trial and demo copies of the software application are 
available for you to try. 

The following is a partial listing of the types of developer tools and utilities you can use to build a 
consultant’s “toolbox” to help you better serve your clients: 

• Move transactions freely between QuickBooks data files. 

• Fix “broken” QuickBooks data files (for example, data files that are too large, or transactions that 
have been posted to the wrong QuickBooks data file). 

• Import non-QuickBooks transactions into a QuickBooks data file. 

Finding Applications that Work with QuickBooks 
A complete list of the tools and utilities available can be found at http://marketplace.intuit.com. See 
Figure 64.  

On this site, helpful software tools are listed by industry or business function. Some examples of 
Industry are Construction, Retail, Nonprofit, and Transportation. A few examples of business function 
are Ecommerce, Wireless and PDA, Billing and Invoicing, Banking Integration, and Shipping.  
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Select from a list of industries or business needs to drill down for more information about related tools. 
 

 
Figure 64 - QuickBooks Solutions Marketplace 

Using Other Integration Tools 
In addition to the integration tools and features covered in this guide, QuickBooks provides other 
integration features, making it possible for users to streamline workflow and be more efficient in 
processing daily activities. Examples of these additional integration features include: 

• Credit card processing through QuickBooks Merchant Services 

• Online banking3 

Of course, the advantages of using one or more of these additional integration features include less 
time spent entering data, full integration with QuickBooks software, and reduced transaction costs. For 
more information on QuickBooks Merchant Services or online banking options visit 
www.accountant.intuit.com. 
 

                                                                          
3 Each of these services is an add-on service and additional charges may apply.  


